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CHAPTER I 

Introduction 

 

Event-related potentials (ERP) that are regarded to be the 

psychophysiological technique of studying attentive processes, language, and 

memory functions in the typical and clinical population, help to produce data 

that is not accessible from behavioral studies. ERPs are brain responses to 

induced stimuli, which are primarily visual and auditory, presented 

repetitively at randomized intervals, and subsequently processed by software 

(computer) tools. The potential produced in reaction to the stimulus has 

varying amplitudes till 5μV microvolt and adequate electrode placement and 

positioning enables to process various stimuli from various electrodes to 

extract the target response from continuing electroencephalographic (EEG) 

recordings (background activity). The recording will be carried out in an 

electrically shielded and sound-attenuated room, where the noise levels are 

within permissible limits. The auditory evoked potential is the most commonly 

used technique for obtaining P300. P300 is a positive ERP waveform with a 

maximum peak of around 300 ms post-stimulus. The P300 often vary 

concerning the mode of response, such as auditory or visual, or other language 

modality. The literature reveals that the integrated stimulus, for example, 

audio-visual mode show better responses when compared to a single stimulus.  

The P3 wave is evoked by a task known as the oddball paradigm. During this 

task, a series of one type of frequent stimuli (standard stimulus) is presented 

along with a different type of non- frequent (target) stimulus (Squires et al. 

1976). The task of the experimental subject is to react to the presence of the 
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target stimulus (for example- auditory) by a given motor response. These 

evoked potentials are categorized into exogenous potentials (N100, P200, and 

N200) because they are greatly affected by physical stimulus features 

(intensity, frequency, and others) and endogenous potentials (P300), which 

reflect only cognitive abilities.  

The P300 element is described as the largest and most solid positive 

peak that occurs between 250 and 500 milliseconds after a rare (occasional 

relevant-'target') stimulus that generally occurs after the two negative N100 

and N200 elements and the positive P200 component. The auditory P300 is an 

evoked potential of a positive long latency peak, which helps in the central 

nervous system's research of the aural cortex. It helps to depict the cortical 

activity that includes discriminative, integrative, and attention abilities, 

allowing the finest indicator of cortical processing velocity through auditory 

stimulation. 

The P300 element can be subdivided into two sub-components, P3a 

and P3b, reflecting distinct operations, as mentioned by Squires et al. (1975), 

with the former being more linked to passive attention and the latter being 

linked to active attention and memory in particular. Therefore, many studies 

have suggested that ERPs are considered as the best indices for assessing 

changes in cognitive brain functions. The oddball paradigm consists of 

infrequent tones that elicit a frontal subcomponent of P300, namely, the P3a, 

which is deemed as an electrophysiological indicator of the orienting response 

(Squires, Squires & Hilliard, 1975). 
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The P3a is a front-centrally maximum favorable ERP wave elicited by 

deviant or unexpected events (Squires, Squires, & Hillyard, 1975, 

Pfefferbaum, Christensen, Ford, & Kopell, 1986) and is regarded as an 

attentive switching electrophysiological marker, i.e., the orienting response 

(Squires, Squires & Hilliard, 1975). P3a is produced by a complicated cerebral 

network, which includes prefrontal, cingulate, temporoparietal and 

hippocampal areas (Sutton, Braren, Zubin, & John, 1965), and is recorded in 

extensive anterior and posterior scalp areas (Courchesne, Hillyard, & 

Galambos, 1965). Smaller peak latency, more front-oriented scalp topography, 

and different elicitation conditions differentiated it from P300 and in P3b were 

elicited by expected events, and responses are elicited from temporoparietal 

regions, i.e., in the posterior regions of the brain. 

The P300 studies, so far in clinical practice, is used as a 

psychophysiological tool for early diagnosis of many neurological disorders, 

including Alzheimer's disease (Olichney & Hillert, 2004), schizophrenia 

(Heidrich & Strik, 1997; Kirino, 2004), epileptic patients (, Mazzini, 2004), 

alcoholism and drugs (Polish, 2004). The consequence of this neurological 

damage and the older population is frequently noted to be abnormal in their 

cognitive functions. Amplitude and latency are measured in the typical and 

clinical population for the peak and widely researched parameters. Information 

processing influences the P300 parameters such as latency and amplitude and 

also influences the cognitive skills such as attention, stimulus assessment, 

judgment, memory processing, and input auditory stimulus decision making.  

Auditory P300, a positive parietocentral peak that occurs after stimulus 

starts at about 300ms when a participant detects an occasional target stimulus 
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in an active oddball paradigm in a periodic fashion of standard stimuli 

(Desmedt et al. 1965; Sutton et al., 1965). The P300 reflects simultaneous 

activity in several areas of the brain, including temporoparietal, neocortical, 

and higher limbic systems (Halgren, Baudena, & Clarke et al., 1995). P300 

amplitude is also the level of attention dedicated to a particular task and linked 

with superior mental efficiency (Gonsalvez & Polich, 2002). Therefore, P300 

amplitude can be considered as a measure of Central Nervous System activity 

reflecting incoming data processing when integrated into the depictions of 

stimulus memory and the context in which the stimulus exists. Consequently, 

variation in the amplitude of P300 is assumed to represent the degree or 

quality of the information processing.  However, there is a need to assess the 

activation of the same neocortical and limbic areas in the brain of individuals 

with aphasia before they initiate speech-language therapy. Therefore, it is 

independent of the reaction time of the behaviour (Kutas, McCarthy & 

Donchin, 1977; Polich, 1986).  

However, these characteristics make the P300 a useful tool for 

cognitive function evaluation: since P300 latency is a measure of the 

processing time needed before response generation, it is a delicate temporal 

measure of the neuronal activity underpinning the attention allocation and the 

immediate memory process. Besides, P300 latency is negatively 

correlated with mental activity in normal individuals, with shorter latencies 

associated with superior cognitive outcomes. The neuropsychological tests, 

best correlated with P300 latency, are those that evaluate how quickly subjects 

can allocate and retain careful resources. Results showing that P300 latency 

rises as cognitive capacity reduces from dementing disease also support this 
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connection. Thus, in both neuro-typical and clinical populations, P300 latency 

is directly correlated with cognitive ability. But, there is no clear evidence of 

these changes during speech-language therapy in individuals with aphasia 

associated with varied neuropathological changes, aphasia symptoms with or 

without cognitive issues during the acute stage of transient ischemic attack 

(stroke).  

The aim of the study by Helm-Estabrooks (2002) was to illustrate the 

status of cognitive abilities in a specific group of people with mild to severe 

aphasia and 13 individuals with right-hand left hemisphere stroke (5 females 

and 8 males) from different locations across the United States and the results 

suggested that scores acquired in a cohort of four non-linguistic cognitive-

linguistic quick tests (CLQT) tasks chosen to briefly assess visual attention 

and memory, executive functions and visual-spatial skills. The analysis of the 

individual profiles of task results exemplified the poor relationship between 

linguistic and non-linguistic tasks. For illustration, one of the two patients with 

overall non-linguistic scores above the normal age cut-off had mild language 

deficits, and the other had severe deficits. Of the six patients with severe 

linguistic deficits, three had relatively low non-linguistic skills, had non-

linguistic scores near or above normal, two had significantly impaired non-

linguistic skills, and one had a moderate impairment. This would tend that 

next to language, executive functions are cognitive skills most susceptible to a 

consequence of brain injury associated with aphasia. And concludes that in 

aphasics with varying severity, there are varying non- linguistic deficits are 

seen in aphasics; thus, there is critical need to study the cognitive attributes in 

subjects with aphasia objectively. However, there is a need to assess the 



6 
 

activation of the neocortical and limbic areas in the brain of individuals with 

aphasia at the initiation of speech-language therapy. 

1.1 Need for the Study 

An early sign of P300 could be useful from dementia-related studies in 

assessing cognitive function. P300 peak latency in dementia patients was 

prolonged compared to age-matched, healthy participants (Goodin et al., 

1978). Consequent clinical studies have shown that P300 amplitude declines 

and increase its latency in the presence of cognitive deficiency (e.g., Polich et 

al., 1986; O'Donnell et al., 1992; Potter & Barrett, 1999). P300 may serve 

overlapping functions in research on cognitive dysfunction in a normal and 

clinical population. It is considered as the clinical assay of a disease-associated 

marker. Polich and Herbst (2000) have demonstrated that measurements of 

P300 in terms of measurement variability are comparable to standard clinical 

laboratory procedures. 

Another role of P300 is to provide helpful data to discriminate between 

disorder subtypes or mechanisms of pathophysiology. By referring patient 

information to normative values and a thorough comparison of disease 

subtypes, each of these features can be obtained from P300 results. In creating 

a differential diagnosis and planning interventions, such data could be useful. 

Impaired attention may be the omnipresent clinical symptom of 

neuropsychiatric illness (Mirsky & Duncan, 2001), and P300 is a delicate 

measure of attention resource allocation ability (Johnson et al., 2004). Altered 

P300 might not be specific to a particular neuropsychiatric condition; 

however, it is a possibly helpful clinical research instrument due to its 

sensitivity to impaired attention and elicitation ease. P300 was used widely in 
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investigating psychiatric and neurological conditions and also in normal and 

abnormal development concerning research of fundamental information 

processing. Studies have, therefore, confirmed the usefulness of ERPs as 

prognostic indicators in patients with severe brain injuries of different 

etiologies and levels of consciousness. 

 P300, together with other ERP measures, retains better evaluation in 

communication-impaired people to monitor cognitive function (D'Arcy et al., 

2000). Hence, there is a need to imply the neurophysiological assessment 

(P300) for comparing the neuro-typical individuals with the individuals with 

aphasia to obtain the neurophysiological data to distinguish between the 

normal population and the individual with aphasia.  

1.2 Aim 

The aim of the present study was to conduct a neurophysiological 

assessment (Event Related Potential-P300) in individuals with aphasia in 

comparison with the neuro-typical individuals. 

1.3 Objectives 

1. To conduct a neurophysiological assessment (Event Related 

Potential-P300) and measure the latency and amplitude of 

individuals with aphasia in comparison with the age matched neuro-

typical individuals. 

2. To obtain the topographical representation of Event Related 

Potential (P300) response of individuals with aphasia in comparison 

with the neuro-typical individuals. 
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CHAPTER II 

                                        Review of Literature 

 

In the findings of late 1960s, presentation of stimulus produces a 

resultant significant increase in the synaptic activity in millions of neurons 

simultaneously in a synchronized manner. This was analyzed on a careful 

analysis of the electroencephalogram (EEG). This combined electrical 

response of the neuron is known as event-related potentials (ERPs). Event-

related potential (ERP) are those potential that should be elicited by their 

induced stimulation which can neither be the visual, tactile, auditory, these 

event-related potentials could be categorized as exogenous and endogenous 

based upon the principle of generation. According to (Donchin, Ritter, & 

MCCallum, 1978), exogenous depends on the physical factors that are likely 

to vary due to the external factors like stimulus type, intensity, frequency. In 

contrast, the endogenous potential depends upon intrinsic factor-like 

cognition. The cognitively evoked response is the P300 since the response 

from the participants primarily depends upon the discrimination between the 

rare and common stimuli in the oddball paradigm (Sutton et al., 1965). 

In the recording of P300, the specially designed paradigm is used 

called as the oddball paradigm, the paradigm includes 2 category of stimuli 

i.e., frequent and occasional stimuli, where the subject’s task is to discriminate 

and attend to the infrequent stimuli, which is used across the research and 

various clinical setups. In the literature, it was reported that, if the subject 

attends to the infrequent stimuli, which is associated with large P300 

components that are with higher amplitude in the sites of posterior electrode 
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rather than an anterior site which shall be correlated with the cognitive process 

that includes context updating, context closure, and event categorization is 

very well documented by Donchin and Coles (1988) and Kok (2001). 

2.1 Components of P300 

P300 consists of two crucial elements, namely P3a, P3b, which are 

seen, imposed to a single wave, even separated with distinguished peaks. P3a 

peak is present when the subject passively listens, whereas P3b is obtained 

when the subject is actively listening (Bennington & Polich, 1999). The 

latency of the P3a element is shorter, and the amplitude is reduced than 

compared to P3b, which is considered as the attention- dependent element.  

At the functional level, according to Polich and Herbst (2000), P3a is related 

to an “attention orienting complex,” whereas P3b is related to psychological 

constructs such as controlled “cognitive closure”, or “response-related 

decisional stages”, “information processing”, and “context updating”. 

Concerning the allocation topography (Friedman et al., 2001), P3a has a 

frontal allocation, and P3b has a parietal allocation, that associate with the 

cognitive functions like context updating, context closure, and event 

categorization.  

In context updating, the subjects always have some "expectancies," 

"schemata," or "models" of a situation. If a stimulus causes that subjective 

context to change (be "updated," "revised"), this elicits a P3. P300 reflects a 

process invoked when the updating, or 'refreshing,' of representations in 

working memory is required. In context closure, the hypothesis assumes that 

this structured and repetitive design of tasks is not only necessary for 

measuring P3 reliably but is also a favorable condition for evoking P3s at all: 
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P3s are emitted by subjects when dealing with a repetitive, highly structured 

environment. Subjects combine the successively presented stimuli into 

meaningful contexts. P3-eliciting stimuli are those events that close these 

contexts and the process of closing is reflected by P3. Besides perceiving 

every single stimulus and responding to it, subjects maintain an internal 

template of the context, which includes maintaining an expectancy of the 

event that will close the context. Thus, when the stimulus is the expected one, 

stimulus evaluation leads to response selection on the one hand and closure of 

the present context on the other. Event categorization is conceived of as a 

process that leads to the decision that the external stimulus matches (or does 

not match) with an internal representation of a specific event or category of 

stimuli. A suitable example of such a category is target stimuli. Event 

categorization involves both perceptual and central processes, as the meaning 

of a stimulus or category of stimuli (e.g., “it’s a target” or “it’s not a target”) 

can only be established after some contact between the perceptual system and 

the memory system has taken place. 

2.2 Generators and Scalp Distribution of P300 Assessment 

The topographic distribution of P300 measures was studied in the 

study which elucidates the relationship between the amplitude, latency and age 

dependence of the P300 wave often differs with the electrode site and 

evaluation of the topographic distribution of P300 latencies showed that P300 

latencies depended on the electrode area of P300 scalp distribution, defined by 

a shift in amplitude over midline electrodes (Fz, Cz, Pz.) increased from 

frontal (Fz) site along the parietal mid-sagittal plane (Pz) (Johnson, 1993). 

P300 potentials have been obtained from the primary auditory cortex and poly 
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sensory cortex association according to the study by (Buchwald, 1990) and 

temporo-parietal cortex is added up with the generation of P300 ( Picton & 

Hillyard, 1974). 

The P300 can provide insight into the various cognitive processes 

underlying it. Various methodologies, such as intracranial recordings, lesion 

studies, and functional imaging studies, have shown that the areas of the brain 

involved in the generation of P300 are complex with the concurrent activation 

of overlapping sites. P300 is widely spread with the maximum amplitude 

detected at the centro-parietal area, and the amplitude reduces as the non-

inverting electrode is positioned to more anterior locations (Bennington & 

Polich, 1999). For identification tasks, P300 is maximum for frontal-central 

and discrimination tasks, the largest of which is just posterior to the vertex 

(Simon, Vaughen & Ritter, 1976). 

The review mentioned in the above sections was discussed with 

reference to the “Generators and Scalp Distribution of P300” in neurotypicals, 

and there is a need and an interest to study the same on the clinical population 

specifically on persons with aphasia. In a study by Onofrj et al., (1995), the 

participants included were 6 subjects with frontal, parietal and temporal lobe 

lesions, and 4 subjects with primary progressive aphasia (PPA)  and 56 age-

matched controls were recorded for linked earlobe reference (LER) using 

auditory oddball paradigm. The computed average reference (AR), latencies, 

amplitudes, and scalp distribution was recorded. These findings were found to 

be within the normal limits for both the LER and AR recordings. When LER 

was used, the distribution of P300 scalp in patients with neurological lesion 

was normal, whereas when the P300 was recorded using average reference, it 
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was found that the distribution of scalp recording was statistically different 

from the normal distribution in all patients with the neurological lesion. 

However, positive P300 was observed in the control group, and in the patients 

with the neurological lesion, it was found to correspond to the affected side of 

the brain.      

From the latest review article by Pavarini et al. (2018), there is no ERP 

study in individuals with aphasia nor a study depicting the Generators and 

Scalp Distribution of P300 in aphasia. Instead, there are studies reported on 

generators and scalp distribution of P300 in the elderly population and other 

neurological conditions. The review of 26 articles revealed that in P300 

evoked potential assessment, there was prolonged latency and reduction of the 

amplitude as the age advanced, and the process of aging that occurs was 

naturally. In the neurogenic condition like Parkinson’s disease, cognition loss, 

depression, and Alzheimer’s disease, latency showed major variability when 

compared to the healthy older individual than the amplitude measure with 

reference to stimulus used (auditory + visual) and also with respect to the 

parameter and setting of the stimulus. P300 measures varied, but no 

explanation w.r.t scalp distribution potentials were documented. Thus, in the 

literature, there are no studies that documented the scalp distribution in 

individuals with aphasia. Hence, the present study was planned to elucidate 

the P300 topographic findings in individuals with aphasia in comparison with 

the neuro-typical individuals.  
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2.3. Variables of P300 Assessment 

2.3.1 Stimulus Specific 

A P300 response varies regarding the mode of the stimulus. Picton 

(1984) observed that a visual stimulus that was used to evoke P300 was 

delayed with 90ms in contrast to auditory stimuli. Polich and Pitzer (1999), 

observed that P300 evoked potential are not stimulus-specific, as P300 waves 

can be evoked by any stimulus like auditory, visual, somatosensory, olfactory, 

and even the gustatory stimulus. However, the amplitude, latency, and the 

source of generation vary with the stimulus modality applied (Bennington & 

Polich, 1999; Johnson, 1989). 

 Knott et al., (2003), studied the impact of the modality of stimulus 

used in P300 in younger and older adults group, and observed greater 

amplitude, prolonged latency when compared with the auditory mode of 

stimulation, age effect was also seen with contrast to the stimulus modality, in 

the younger group, latency suddenly changed at around 12 years of age, 

whereas the latencies of the P300 which was evoked by the visual stimulus 

was found with steady decrease with age and concluded that the latency of the 

visual modality of stimulus is slow, shorter latency then the auditory and as 

the age increase, it (visual evoked P300) was observed to be longer than 

auditory evoked P300 in older children and no such trend was noticed in 

amplitude parameter. 

 A study was conducted in which the intensity was used as the variable, 

the effect of intensity variation and P300 outcome was measured, the results 

revealed that, when the intensity was increased from 15 to 65dB, the variable 

influenced the latency rather than the amplitude of P300 (Papanicolaou et al., 
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1985). In contrast, Vesco ( 1993) found that when the intensity of the stimulus 

varies, the amplitude is influenced by the intensity of stimulus variability. 

Bennington & Polich (1999) did a comparison study between a passive and 

active task in the normal population, the active task included finger raising on 

the stimulus attended, and passive task included daydreaming, results reveal 

that amplitude was greater for the active task when compared to the passive 

task. 

Regarding the sound environment favorable for the P300 recording, 

Arikan et al., (1999) compared the white noise versus the music culturally 

adequate to find the effect on P300, the oddball paradigm was used, and the 

result is that amplitude decreased in white noise due to its SNR characteristics. 

2.3.2 Subject-specific 

The two tasks namely, numbering the stimulus and pushing the button 

with the thumb was studies, it was observed that the latency was longer and 

amplitude was increased in the P300 evoked potentials according to Donchin 

& Coles (1988). They reported that the highest amplitude value of 20 mV was 

significantly correlated with the greatest attention allocated to the target 

stimuli and thus conclude that the P300 amplitude can be considered as the 

index of CNS processing attributed to the attention processing (Polich, 1998; 

Donchin & Coles, 1988). 

The P300 evoked potential has an effect on sleep, and it was observed 

to be prolonged. The latency was prolonged, and the amplitude was decreased 

when the subjects were subjected to sleep deprivation (Danos et al., 1994). In 

some conditions like when the subject transforms from alert wake state to 

drowsiness and followed by stage I sleep, P300’s evoked potential amplitude 



15 
 

reduction was clinically observed in the wave morphology (Koshino et al., 

1993). The stage I sleep is described as when one finds themselves floating in 

and out of consciousness. During this non-rapid eye movement sleep, one may 

be partially awake, and their mind begins to drift off. This leads to light sleep 

and is a period of drowsiness.  

The effect of memory (Long term memory) on electrophysiological 

assessment is also studied. The relationship between memory and the P300 

evoked potential was researched by Johnson et al. (1984) on the normal 

population. The task was to memorize the list of words before initiation of the 

P300 recording, and on behavioral assessment, the task of the subjects was to 

list out the memorized words. Following this behavioral task, a P300 

recording was carried out in both non memorized words and memorized 

words. It was found that the larger amplitude for the non-memorized words 

and reported shorter latency for the memorized list of words where the 

subjects were made to memorize in the initial phase of the behavioural task. 

So concluded that the memory rehearsal method affects the P300 amplitude 

and latency measures. 

The effect of acute alcohol consumption with the measures of P300 

assessment was also studied by (Porjesz & Begleiter, 1981) and found that 

they have declined amplitude compared to the group who did not consume 

alcohol. Lukas et al, (1990) added that acute alcoholism could disturb and 

change the neural generator for P300 generation to more inferior brain regions. 

 

 



16 
 

2.4 P300 and Cognitive Processes in Other Neurological Disorders 

P300 is considered one of the most important tools in the evoked 

potential of the ERP studies, which focuses on the study of cognitive functions 

in the typical individual with typical cognitive function in comparison with the 

clinical population with cognitive processing deficit. According to Ford 

(1999), P300 acts as a biomarker in the evaluation of the schizophrenic 

individual, with the findings that there would be a reduction of the amplitude 

of the P300 component. 

The evaluation of clinical population in the clinical settings have 

provided an insight that the P300 was considered as the better tool for early 

identification of many neurological disorders (Olichney & Hillert, 2004) like 

Alzheimer’s disease and Schizophrenia (Kirino, 2004) and Epileptic patients 

(Mazzini, 2004). Future direction by a review article (Pavarini et al., 2018) 

includes that to elucidate in older individuals to evaluate relationships among 

education and P300 measures, education, and gender. No normative data are 

obtained from the articles concerning the P300 measures (latency and 

amplitude) for clinical populations. 

2.5 P300 and Cognitive Processes in Neuro-typical Individuals 

Research conducted on 115 neuro-typical individuals in the age range 

of 10-70 years and dividing into two groups based on the ‘age,’ i.e., above 40 

constituting one group and below 40 years constituting another group. The 

P300 was recorded for all the individuals, and the results revealed that the 

mean latency was 361.5±32.9 msec (range 295 to 438 msec) whereas the mean 

amplitude was 9.32 ±5.11 uV (range 2.47 to 20.41 uV). There was a 

significant variation in latency between the two age groups. The possible 
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reason for this could be as the age increases, the neural firing decreases, and 

these results in poor latency resembling the longer time taken by the neurons 

to stimulate for the task. With reference to gender, males and females showed 

no significant difference in the latency of P300. In the 40 years and above age 

group, the amplitudes were lower, but the difference was only significant for 

males. There was an adverse correlation between the amplitude and latency of 

the P300 (r= -0.20). A significant positive correlation between age and P300 

latency was observed, whereas the P300 amplitude showed a significant 

negative correlation in less than 40 years of age (Shukla et al., 2000). 

Another study was to generate normative data of auditory P300 event-

related potential in the Indian population (Uvais et al., 2018) they had included 

155 healthy participants in the age range of 10 -50 years. They had been 

further divided into four groups like 10-19 years, 20-29 years, 30-39 years, 

and 40-50 years. The recording was done in three different sites Fz, Cz and Pz 

and the results reveal that the Mean and Standard Deviation of the P300 

amplitude and latency of Fz, Cz, and Pz for the four age groups ranged from 

4.97 to 7.84 (Fz), 7.90 to 11.77 (Cz), 9.46 to 16.17 (Pz) the amplitude and 

349.61 to 366.81 (Fz), 348.31 to 358.06 (Cz) and 350.29 to 354.23 (Pz) the 

latency. The study showed significantly higher amplitude on 10-19 years 

compared to other age groups in Fz and Pz position; however, it has also been 

mentioned that the amplitude was higher on 30-39 years age group in the Cz 

position. The study also mentioned that there was a significant decreasing 

trend of P300 amplitude at Fz (P<0.001), Cz (P=0.002), and Pz (P=0.015) 

across ages. There were no such trends seen for P300 latency. 
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2.6 P300 Assessment in Clinical Conditions like Aphasia  

A study was done by Peach (1991) on six participants with the 

diagnosis of aphasia (3 males and 1 female) and was compared with 2 age-

matched normal (one male and female) participants in the age range of 69-72 

years. The individuals with aphasia were subgrouped as 2 subjects diagnosed 

as fluent and 2 diagnosed as non-fluent, and each of the aphasia participants 

was administered with object naming task after completion of language testing 

and ERP recordings. The results indicated that responses from the aphasic 

group were variable and found that the latencies were prolonged in the aphasic 

group when compared to the healthy control group. 

Another study by  Korpelainen et al., (2000) included 38 aphasic 

patients (23 men and 15 women), with mean and SD age 67.1±7.2 years, range 

44±78. All participants had an acute brain infarction, and P300 was recorded 

using an auditory oddball paradigm among these 38 brain infarct patients who 

reported mild neurological deficits at 3 and 12 months post-stroke period. In 

comparison with aphasic patients, 29 healthy control subjects were also 

considered. The results indicated that slight prolongation of the latency of the 

P300 was seen in patients with brain infarction, and the delay was 

observed related to the existence and extent of post-stroke depression assessed 

with the Zung Depression Scale and the DSM-III criteria. It was noted that the 

infarction did not influence the amplitude of the P300 or its distribution on the 

scalp. Outcomes for subjects with hemispheric cerebral infarction and patients 

with cerebral infarction were identical. The findings for patients with left-and 

right-sided lesions and also the normal physiological correlation between the 
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participants' age and latency of P300 was lacking at 3 months post-stroke, but 

it was detectable at 12 months post-stroke. 

Individuals (right-handers) with left hemisphere damage (total 17 in 

number) diagnosed with global aphasia with the mean age of 65 years were 

considered for the study by Nolfe. et al., (2006). P300 recording was carried 

out for this clinical population in comparison with the 20 age-matched neuro-

typical individuals. The mean time interval between the stroke onset and the 

first P300 documenting was 12.9 days (SD, 5.8). The recording was carried 

out with 16 scalp electrodes in accordance with the international standard 10–

20 system; recordings were rendered once a month at the very same time after 

breakfast in a day. Stimuli were produced through binaural headphones; an 

inter-stimulus interval of 2 sec had been used. The pre-recorded stimulus 

series has been addressed without guidelines. The stimulus included was the 

oddball paradigm, which consisted of high-pitch (1 kHz) uncommon stimuli 

and low-pitch (0.5 kHz) common stimuli, and language abnormality was 

evaluated by the Aachen Aphasia Test (AAT) in the version validated for the 

Italian population. Two subjects were examined in particular: (i) Token test; 

(ii) Comprehension and the results indicate that seven patients (41 percent) 

had P300 responses in the right hemisphere at the early part of rehabilitation, 

taking into account parietal and temporal derivations; six of them (35 percent 

of the total group) had P3 responses, and finally, three (18 percent) had P300 

responses in all derivations. Specifically, in temporal-parietal derivations, the 

P300 wave had greater and well-defined amplitude. In these clients, moreover, 

the voltage of the P300 component in the frontal area is negligible. On the 

other hand, the participants lacking the P300, however, presented the P100–
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N200 complex and well-defined amplitude on the frontal areas but absent on 

temporal-parietal derivations. Compared to the controls, the mean latency of 

the patients was significantly increased in all of the examined channels. By 

contradistinction, amplitude distinctions have only reached statistical 

significance in the P3 derivation. 

The P300 amplitude scalp topography, quantified at discharge in 

patients with this ERP component at enrolment, shows the same information 

calculated in subjects without any P300 responses at baseline. With reference 

to the clinical prognosis for recovery of comprehension, all participants were 

classified as suffering from global aphasia, at both baselines and at discharge 

(therapy termination time). After 3 and 6 months, two AAT sub-items, notably 

comprehension and Token Test, had been administered at the baseline. Global 

aphasic patients who had a P300 response in the first month had a better AAT 

comprehension advancement over time than those without P300. Nevertheless, 

there was no objective evidence of latency and amplitude improvement found 

over time. But, the computerized P300 amplitude maps computed at a patient 

therapy termination might be of importance in offering insights for assessing 

recovery after stroke in global aphasics, and the grand average map shows the 

evolution of global aphasia towards Broca's aphasia in these participants. In 

reality, they had a great recovery of comprehension. In contrast, the group of 

participants lacking early P300 had no improved performance of 

comprehension, and the authors conclude that the usefulness of the P300 

response in the clinical assessment of post-stroke aphasia since its early 

existence can predict a rapid recovery of language comprehension. The ERP 

experiments can track the progress pattern further than the first months as well 
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as provide data on the areas most affected. This research was the only one to 

monitor ERPs monthly. Further ERP researches must follow the recovery 

pattern further than the first 6 months after the stroke.  

  Aerts et al. (2015) conducted a single case study to examine the effect 

of language therapy integrating behavioral and neurophysiological findings 

and discussed the clinical outcomes in patients with aphasia during acute and 

post-acute stages of stroke. The subject was a 47-year-old man with moderate 

non-fluent aphasia who had undergone three treatment periods in the first four 

months after his stroke. The initial assessment period occurred 10 days after 

the stroke. First, he obtained an intensive 30-hour language treatment in 3 

weeks, followed by a 30-hour conventional treatment in 7 weeks. Then, in 

three weeks, the subject received a second, intensive language therapy of 30 

hours. It was followed by a period of six months with no sort of language 

treatment. Behavioural and neurophysiological measures were gathered after 

each treatment and treatment period. The effect of therapy was investigated by 

equating the duration of treatment with the duration of the treatment without 

differentiating between intensive and conventional treatment. In the second 

analysis, a comparison was made between both the intensive treatment periods 

and the traditional therapy program, and the tasks included the phoneme 

discrimination task. The standard phoneme was /bə/ and the deviant phoneme 

was /gə/ (covering place of articulation- PoA), /pə/ (covering voicing), 

and /mə/ (covering manner of articulation- MoA). Stimuli were developed in 

such a manner that perhaps the standard and deviant stimulus differentiated 

only in one phonemic contrast. The standard and deviant phoneme appeared at 

a probability of 0.80 and 0.20, respectively. The stimulus was provided in a 
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random fashion wherein two deviants cannot adopt one another without 

getting one standard in between. All the phonemes spoken had a duration of 

150msec. The results indicate that participant’s responses for phoneme 

discrimination had shown smaller amplitudes, particularly in comparison to 

the normative group for all phonemic contrasts (PoA, voicing, and MoA) in 

P300. Participants showed shorter P300 latencies for PoA, longer P300 

latencies for voicing, and the largest P300 latencies for MoA compared to the 

normative group. After the complete therapy period, the P300 assessment for 

PoA, voicing, and MoA showed increased amplitude, while PoA and 

voicing had increased. After the treatment-free period, P300 PoA, voicing, and 

MoA amplitude reduced, and it infers that participants reveal a marked 

improvement in both behavioral and neurophysiological measures after that 

complete treatment period, that was maintained across the treatment period. 

Intensive treatment led to better language results, as stated by behavioral and 

neurophysiological improvement, as opposed to the behavioral degradation of 

auditory discrimination against pseudo words. 

Therefore, researches utilizing ERPs that are promised on oddball-

paradigm support to describe, assess, and track phonological issues and 

auditory comprehension deficits in clients with aphasia to a larger extent. It's 

been discovered that perhaps the P300 is a decent non-invasive indicator to 

compare the clinical population with that of neuro-typical and monitor 

recovery patterns in initial stages of aphasia and long-term follow-up phases 

and compare between two therapy approaches too (Aerts, van Mierlo, 

Hartsuiker, Santens & De Letter, 2015). 
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CHAPTER III 

Method 

 

3.1 Participants 

 A total of 8 individuals participated in the present study. Among them, 

4 individuals with aphasia were selected based on the availability of cases in 

the Department of Clinical Services, All India Institute of Speech Hearing, 

Mysore as a clinical group. These participants had a diagnosis of 'Aphasia' by 

the Neurologists and the Speech-Language Pathologists after the 

administration of Western Aphasia Battery (Chengappa & Kumar, 2008). 

These individuals had just initiated their speech and language therapy and had 

attended less than five sessions before recruiting them for the present study. 

The other 4 individuals were neuro-typical, recruited from in and around 

Mysore as participants of the control group. These were relatively matched 

with the chronological age, gender, and educational background of individuals 

with aphasia. The demographic details of all the participants of the clinical and 

control group and are as follows in Table 3.1. 
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Table 3.1 

Demographic Details of Participants in Clinical and Control Group 

Sl No. Participants Age Gender Educational 

Status 

Aphasia type WAB scores AQ 

scores 

Neuro-imaging findings languages 

known 

            SS N R AVC      

1. A  25yrs M Secondary 

Education 

 Global Aphasia  0 0 0 1.2 2.4 MRI: 27.08.19 

Acute onset of aphasia and 

right sided weakness 

CT SCAN without contrast: 

05.09.19: 

I11 defined hypodensities in 

left peri-rolandic cortex and 

temporo occipital cortex- sub 

acute infarcts. 

 Kannada, 

English 

2. B 65yrs  M Nil Broca’s Aphasia 0 0 0 8.5 17 Hyperacute infarct involving 

frontal operculum and 

posterior frontal regions 

 Konkani, 

Kannada, 

English & Hindi 

3. 

 

 

 

C  28yrs 

11 

months 

 M  Not 

mentioned 

Occupation:  

Fertilizing 

Manager 

(Agricultural 

dept.) 

 Global Aphasia 

(Resolving to 

Broca’s Aphasia) 

Re-

Evaluation:18.12.19 

Broca’s Aphasia 

 0 0.4 0.2 3.35 7.9   

Left fronto-parieto-temporal 

lobe chronic infarct with 

gliosis 

Kannada, 

English, hindi, 

telugu, tamil. 

0 0 0 4.4 8.8 
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4. 

 

 

D 

  

45yrs 

 

F 

 

Secondary 

Education 

 

Broca’s Aphasia 

 

2 

 

0.8 

 

0.3 

  

7.85 

 

21.65 

 

MRI: 31.08.17 

Acute non heamorhagic left 

MCA territory infarct with 

mild mass effect, no gross 

midline shift. Question focal 

thrombosis in the M2 

segment of the left cerebral 

artery 

CT: 06.09.17 

Mild interval decrease in the 

size and mass effect of 

subacute infarct of the left 

MCA territory involving the 

left gangliocapsular region, 

insular cortex, peritotemporal 

lobe. 

 

  

Kannada 

5. 1 28yrs M Master’s 

Degree 

NIL NA NA NA NA NA NA Kannada, 

English 

6. 2 70yrs M Bachelor’s 

Degree 

NIL NA NA NA NA NA NA Kannada, 

English 

7. 3 62yrs M Diploma NIL NA NA NA NA NA NA Kannada, Hindi 

8. 4 65yrs M Degree NIL NA NA NA NA NA NA Kannada, 

English 
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The individuals with aphasia (participants) followed special inclusionary 

criteria and the same are listed below:  

 The post morbid duration was six months or above.  

 Handedness was checked using Edinburgh handedness 

inventory- Revised (Williams, 2010), and the four individuals 

with similar (left/right) handedness (after the post morbid 

condition) only were considered for the present study.  

 Aphasia quotients were falling below 93.8 on the 

administration of Western Aphasia Battery (WAB) (Kertesz, 

1982). Specifically, individuals with aphasia had to have a 

score of AQ in the range of 5 – 10 on the comprehension 

subsection of WAB. 

 Individuals with aphasia were monolingual or bilingual, and 

the languages known by the individuals were noted down. 

 They had no complaint of any otological problems or 

ototoxicity. In order to identify any such issues, a detailed 

general case history was taken.  

 Individuals with aphasia underwent a routine audiological 

evaluation before participating in the study. Air conduction 

thresholds were less than or equal to 30 dBHL in both the ears 

on Pure Tone Audiometry. (Clinical audiometer-Madsen 

OB922, (Version 2.64) with TDH 39 earphones enclosed in 
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MX-41/AR supra oral ear cushions used to estimate the air-

conduction thresholds, and Radio Ear B-71 bone vibrator) 

 Individuals with aphasia had no other associated clinically 

significant neurologic disorders other than stroke. Participants, 

if taking any sedatives and memory dietary supplements, were 

asked to suspend them for 72 hours before testing. 

 Individuals with aphasia had no associated neurogenic speech 

disorders like apraxia or dysarthria, and if present, the same 

was noted during the evaluation processes.  

3.2 Research Design 

 The present study was a standard group comparison, wherein the 

neurophysiological assessments (ERP measurement of P300) of individuals with 

aphasia was compared with that of the neuro-typical individuals. 

3.3 Data Collection Procedure- Electrophysiological Experimental Paradigm 

3.3.1 Testing Environment 

 The recording was carried out in a sound-attenuated and electrically 

shielded room, where the noise levels were within permissible limits (ANSI S3.1-

1999). For the same, the recording room of the Department of Speech-Language 

Sciences was used.   
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3.3.2 Instrumentation  

The following instrument was used to record the stimuli and collect data. 

1. Net Station 5 Electrical Geodesic Inc. (EGI) Geodesic EEG 

Software (version 5.4.2) instrument was used to record Event-

Related Potential (ERP) (128 Channels). 

2. The recorded stimuli which are scaled and RMS normalized was 

used to obtain the evoked potentials, viz., P300. 

3.3.3 Stimuli 

The E-prime software version 2.0.8.90 (Psychology Software Tools, Inc., 

Sharpsburg, PA, USA) on a Hewlett Packard Z240 Tower Workstation (Intel 

Core i5at 3.20 GHz and 8.00 GB RAM) running Windows 7 Pro was used for the 

preparation as well as the presentation of the stimulus. The EGI equipment 

supports two machines for carrying out the experiment. The Net Station software 

records multiple tracks of the stimulus along with the EEG data. Another 

computer generates and presents the stimuli, and it sends simple triggering or 

complex stimulus identification information to Net Station software. The speech 

stimuli used for testing were syllables /ḍa/ and /ga/, where the frequent one was 

/da/ and the infrequent one (target) was /ga/.  These audio stimuli were presented 

from an audio speaker centred 85 cm above the participant connected to a 

Creative SB X-Fi audio card. Speech sounds were presented free field at 70 

dBSPL, measured by a Sound Level Meter (SLM). The interstimulus interval was 

2000 ms. A total of 250 sweeps was presented. Participants were instructed to 

listen to the stimuli. The response to the task depended on the capability of the 
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participants. A 700 msec time window was used, and analysis was based on the 

numerical values of the latencies (ms) and amplitudes (μV). P300 identified as a 

positive deflection after the N1-P2-N2 complex was considered as responses for 

further analysis. 

3.3.4 Recording 

 3.3.4.1 Planning. The participants had to arrive at the recording room 

with freshly washed (not wet) hair and had not used any hair products (for 

example, gels or hair spray) when they had come for recording. Before the 

participant arrives, the electrolyte solution had to be prepared, and the necessary 

items like measuring tape, pipettes, syringes, and three clean towels had to be kept 

ready.  

 3.3.4.2 Preparing the Electrolyte Formulation. As per the Electrical 

Geodesic Inc. (EGI) recommendation, HydroCel Saline (Potassium Chloride 

electrolyte solution) was used for standard recordings, the steps includes. 

1. 10 cc (2 teaspoons) of powdered potassium chloride (KCl) had to be added 

into the rinse/electrolyte bucket. 

2. 1 litre of warm distilled water had to be added to it. 

3. Add 5 cc (1 teaspoon) of Johnson’s Baby Shampoo. 

4. The ingredients had to be stirred vigorously until the KCl is completely         

dissolved.  

5. The solution had to be kept for 5 minutes. 
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 3.3.4.3 Head Measurement. The head measurement had to be found out 

before applying the Geodesic Sensor Net to the subject’s head. The head 

circumference was measured by running the tape along the side of the head, above 

the ear, toward the back and 2.5 cm above the external occipital protuberance 

(Inion), around the other side and above the other ear, and back to glabella. One 

end of measurement tape was placed on the glabella, and the other end was placed 

on the Inion, and the midpoint was marked. Similarly, the midpoint between the 

preauricular joints was marked. The point at which these two intersect is the 

vertex point, otherwise called Cz in the international 10-20 system (Silverman, 

1963). The net of the appropriate adult size was selected based on the 

measurement obtained. Marking the Vertex was as follows: 

1. The subject was asked to hold one end of the measuring tape to the nasion. 

2. The tape was run over the top of the head until it reached Inion, and the 

midpoint was located. The midpoint was marked using a marker on the 

subject's head.  

3. The distance between the preauricular points was measured by extending 

the measuring tape across the top of the head. The midpoint was located, 

and it was marked on the head. The intersection point of these two lines 

gave the location of the vertex.  

 3.3.4.3.1 Net Application. The net soaked in the electrolyte solution (as it 

has sponge inserts), and was safely applied on the participant’s head in such a 

way that the Cz electrode came on the vertex marked on the head. The 

participants were asked to remove earrings, glasses, and hair ties as it would 
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become uncomfortable for them. The sensor net can be applied under ten minutes 

and without scalp abrasion, recording paste, or gel, as the high-density hydrocel 

geodesic sensor nets and associated high-impedance amplifiers have been 

designed to accept impedance values ranging as high as 100 KΩ.  

 3.3.4.3.2 Soaking the Net in the Electrolyte. The net was not soaked for a 

longer time, and care was taken so that the connectors would not get wet. 

1. The sensor end of the net had to be dipped into the “electrolyte” bucket. 

2. The sensors of the net had to dip in electrolytes for at least 5 minutes to 

ensure adequate wetting of the sponges. 

3. A towel had to be given to the participants to catch the electrolyte drips.  

4. A towel had to be draped over the participant’s shoulders.  

5. The net had to be lifted vertically out of the electrolyte bucket and had to 

be held in the same position such that the excess electrolyte drip back into 

the container. 

 Then the net was placed on the participant’s head in such a way that the 

electrode mentioned as Cz was coming on the vertex. It had to be ensured that all 

the electrodes were placed correctly on the scalp of the participant. The chin strap 

had to be moved underneath the participant’s chin and was secured using the cord 

lock. Participants had to rest on the reclining chair while they had to remain 

awake throughout the procedure. It was ensured that the inter-electrode 

impedance was ≤ 50KOhms prior to testing. If the impedance was more, the 

electrolyte solution was put on the sponge on the electrodes. 
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 The electrodes FCz and AFz were regarded as reference and ground, 

respectively during the online recording. Vertical (VEOG) and horizontal 

electrooculograms (HEOG), two additional electrodes, were used to monitor the 

eye movements. Particularly, VEOG was positioned at the right side of the right 

eye (Channels 8, 126, 25, 127), and HEOG was positioned below the left eye 

(Channels 125 and 128). Impedances for all electrodes were kept below 50 KΩ, 

during the whole task. 

 The ERPs that were used to record was P300. P300 was recorded as per 

the guidelines provided by Duncan et al. (2009). Few of the important guidelines 

that were considered in the present study are: 

1. Use of oddball paradigm (passive paradigm, participants would only 

concentrate on stimuli without responses (Pokorny et al., 2013) - as it elicits 

robust P300 and reveals how the brain discriminates stimuli and process 

probability. 

2. A minimum of 36 or more artefact-free trials with correction for ocular 

contributions.  

3. The elicitor stimulus was delivered binaurally through speakers at 70 dB SPL. 

In order to elicit P300, the oddball paradigm was used. The summary of the 

protocol for recording is shown in Table 3.2. 
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Table 3.2 

Summary of the Protocol for Recording P300 

 

Stimulus Parameters Details 

Stimuli  Frequent  Infrequent  

 
   /ḍa/      /ga/  

Frequent: infrequent ratio  4 to 1 (80:20)  

Ear  Binaural 

Transducer Insert – ER- 3A/Speaker 

Intensity  70 dB SPL  

Inter-stimulus-interval  2000 ms 

Total number of sweeps  250  

Acquisition Parameters  

Filters 0.1 Hz -30 Hz 

Electrode  Cap electrode 

Montage Hydrocel GSN 128 1.0 
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3.4 Data Analysis Procedure- Response Analysis 

Artifacts were automatically detected and manually verified for exclusion 

from additional analysis (bad channel >200 microvolts, eye blinks >140 

microvolts, and eye movement >100 microvolts). For every channel, 50% or 

greater bad segments were used as the criteria for marking the channel bad; for 

every segment, greater than 20 bad channels were used as a criterion for marking 

a segment bad.   

Bad channels (fluctuations over 200 µV) were spherical spline 

interpolated from nearby electrodes. Data were baseline-corrected using a 100 ms 

window before the onset of all stimuli. Data were re-referenced from vertex 

recording to an average mastoid reference.  

All processed, artifact-free segments were averaged by condition 

producing a single event-related potential waveform for each condition for all 

participants and exported for plotting and statistical analysis. For analysis, the 

P300 was defined to be the most positive peak between 300 and 700 ms following 

stimulus onset within a cluster of eleven central electrodes. 

The obtained raw electroencephalogram (EEG) file from the Net Station 

Acquisition Program was subjected to preprocessing using the Net Station Tools 

program, and further analysis was carried out using the EEGLAB toolbox within 

the MATLAB software (The Mathworks Inc., MA). 
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3.4.1 Segmentation 

 The obtained continuous raw EEG data had to be segmented first. For this 

purpose, the Net Station Tools program was utilized. Initially, a segmentation tool 

was created using this program to segment the raw EEG data file. This 

segmentation tool was named “Speech segmentation” and “Tone Segmentation,” 

respectively. Within the speech segmentation tool, the parameters were set in such 

a way that segments containing the stimuli /da/ and segments containing the 

stimuli /ga/ were segmented. Each segment consisted of 100ms duration before 

the presentation of the stimulus and 1500 ms after the presentation of the 

stimulus. Thus, each stimulus was segmented in 250 segments (200 segments of 

frequent stimuli /da/ and 50 segments of infrequent stimuli /ga/). Similarly, Tone 

Segmentation Tool yielded 200 segments of frequent stimuli 1 kHz and 50 

segments of infrequent stimuli 2 kHz. 

3.4.2 File Export 

Following the process of segmentation, the files had to be converted to 

Net Station Simple Binary format (.raw) to carry out further analysis using 

MATLAB. For this purpose, the Net Station Tools program was utilized. A file 

conversion tool was created to convert the segmented files into the “.raw” format. 

This was executed for the speech EEG files to obtain converted files in the “.raw” 

format. 

3.4.3 Processing in MATLAB 

EEGLAB plugin (Swartz Center for Computational Neuroscience, CA), 

which is an interactive MATLAB toolbox for processing continuous and event-
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related EEG, was used for further analysis. Further analysis in MATLAB was 

carried out according to Makoto's preprocessing pipeline 

(https://sccn.ucsd.edu/wiki/Makoto%27s_preprocessing_pipeline).  

The steps of processing in MATLAB are as follows: 

Step 1: MATLAB was opened, and the EEGLAB toolbox was loaded into 

MATLAB by typing “eeglab” as shown in Figure 3.1.   

Figure 3.1 

Steps for Adding EEGLAB Toolbox to the Software 

 

Step 2: Importing the binary EGI data file was done for initiating the analysis 

process, as shown in Figure 3.2. 

File > Import Data > Using EEGLAB functions and plugins > From Netstation 

binary sample file > Select the raw data > Ok 

 

 

https://sccn.ucsd.edu/wiki/Makoto%27s_preprocessing_pipeline
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Figure 3.2 

Steps to be Followed for Importing the Data 

 

Step 3:  Importing channel locations (Geodesic Sensor Net Hydrocel 128) was 

done to plot the EEG scalp maps either in 2-D or 3-D template, and for 

approximating data source locations, the EEGLAB dataset must, therefore, hold 

information on the scalp locations of the recording electrodes. The channel 

location was imported and was applied, as shown in Figures 3.3 and 3.4.  

Edit > Channel Locations > Read Locations > Sample locs – GSN Hydrocel 128 

> Autodetect – Ok > Opt Head Centre > Autodetect > Ok  

Figure 3.3 

Steps to Import the Channel Location 
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Figure 3.4 

Steps to Apply the Channel Location 

 

Step 4: Data was then subjected to Finite Impulse Response (FIR) Filtering with a 

bandpass of 0.1 Hz to 30 Hz as shown in Figure 3.5. It was strongly suggested 

that continuous EEG data be filtered before epoch or artifact removal, even 

though epoch data may even be filtered with this function (each epoch being 

filtered separately). Continuous data filtering mitigates the emergence of filtering 

artifacts at epoch boundary, and the data set is saved.  

Tools > Filter the data > Basic FIR Filtering > Set Lower and Higher edge of the 

frequency passband as 0.1 Hz and 30 Hz respectively > Ok 
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Figure 3.5 

 The Steps to Follow for Filtering the Data 

 

Step 5: Initially, the entire EEG data file was screened via scrolling manually 

through channel activities for bad channels and visual artifacts. These were 

removed manually. Following this, a clean raw data EEGlab plugin was applied 

for controlled objective rejection criteria as shown in Figure 3.6.  

Tools > Clean the data using clean raw data and ASR. Figure 3.7 shows the 

rejected data in red colour and the retained data in blue colour. 

Figure 3.6  

The Steps Followed for Cleaning the Data
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Figure 3.7 

The Window with the Rejected and Retained data 

 

Step 6: Interpolation of all of the channels removed was carried out to reduce 

potential bias in the next average reference stage. For instance, if 64 channels 

exist and 16 channels are recognized as bad and rejected, but only from the right 

hemisphere, then the number of channels in the left vs. the right hemisphere is 32 

vs. 16, with a mean bias towards the left hemisphere. To prevent such events, the 

channels were interpolated. In this procedure, when the cleaned data is processed, 

the researcher will note the missing rejected data as well as the channels selected 

in the filtered data set, and the dataset was saved as shown in Figure 3.8. 

Tools > Interpolate electrodes > Select from data channels – Note down the 

channels that are removed > Use specific channels of other data set > Dataset 

Index – Give the number of Filtered Dataset > Select the removed electrodes > 

Ok 
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Figure 3.8 

The Steps Followed for Interpolating the Electrodes 

 

Step 7: The data were re-referenced to the average reference because when the 

EEG is produced on a cortex with a dipolar current distribution and without 

external sources, there are at all times the very same number of positive and 

negative potential changes due to the retention of the charge. Therefore, scalp 

topography should be null. By re-reference to average channel values, we 

presume that there is (really) no generation of charges that are monopolar sources 

and sinks, and also, the average reference is often very helpful in suppressing line 

noise.  

Tools > Re-reference the Data > Compute average reference > Ok as shown in 

Figure 3.9. 
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Figure 3.9 

The Steps Followed for Re-referencing the Data 

 

Step 8: Independent Component Analysis (ICA) was conducted where the 

decomposition of data by ICA (including PCA) includes a linear change of base 

from data gathered by single scalp channels to a spatially transformed "virtual 

channel" premise. In other words, rather than collecting simultaneously recorded 

single-channel data records, the data is processed into a collection of 

simultaneously recorded spatial filter outputs applicable to all multi-channel data, 

and 64 components with maximum channel activity representation were derived 

and components were classified using the IC label.  

Tools > Decompose data by ICA > Commandline option – ‘pca’, 64 > Ok (as 

shown in Figure 3.10) and the components were classified by following these 

steps: Tools > Classify Components > View extended component properties > 

Component indices to plot – 1:64 (as shown in Figure 3.11) 
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Figure 3.10 

The  Steps Followed for Decomposing the Data and the Components Obtained 

After Following the Steps 

 

Figure 3.11 

The Steps Followed for Classifying the Components 

 

Step 9: SASICA plugin was applied to perform the automatic detection of 

artifactual components - The methods include 1). Autocorrelation, which 

identifies noisy elements with weak autocorrelation (usually muscular artifacts). 
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2). Focal components identify components that are too focal and are therefore 

unlikely to match neural activity (usually the wrong channel or muscle artifacts). 

3). Signal-to - noise ratio works by detecting components with a weak signal-to-

noise ratio among both arbitrary baselines as well as interest time windows. After 

applying the plugin another window pops up showing the artefacts in red colour 

which makes it easier to remove the unwanted components as shown in Figure 

3.13. 

Tools > SASICA > Autocorrelation – Enable; Focal components – Enable; 

Correlation with other channel(s) – Enable; Adjust selection – Enable > Compute 

(as shown in Figure 3.12) 

Figure 3.12 

The Steps Followed for Applying the Plugin. 
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Figure 3.13 

The Components with Artifacts in Red Colour 

 

Step 10: Independent Components (ICs) with eye-related or muscle-related 

components were removed, and ICs with activities of interest from the Brain 

(confirmed with the presence of dipoles and ERP waves) were selected as shown 

in Figure 3.14. Tools > Remove components from data > OK > Accept > Save as 

a new file. After removing the unwanted components, the dataset was saved to 

extract epochs from this dataset. 

Figure 3.14 

Steps Followed for Removing Unwanted Components 
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Step 11: Epochs were extracted from the retained ICs with the epoch limit of 0.1 

seconds before the stimulus onset and 0.8 seconds after the stimulus onset for 

both the frequent and the infrequent events. The steps followed were as shown in 

Figure 3.15. Tools > Extract Epochs > Time locking event type – Select the event 

(for example ga) – Epoch limit – Mention as “-0.1 0.8” – Ok  

Figure 3.15 

Steps Followed for Extracting the Epochs 

 

Step 12: Baseline correction was carried out with a latency range of  100 ms, 

where Baseline correction is a common method used during the analysis of Event-

Related Potentials, to account for irrelevant differences in the signal baseline. It is 

applied to an epoch data set by specifying a sub-window, where the mean value of 

the signal in that window is subtracted from the whole signal (by channel or 

component). The Figure 3.16 shows the baseline correction being applied. 
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Figure 3.16 

The Window that Pops up after Step 11 

 

Step 12: ERP image was plotted. The waveform of the P300 potential, as well as 

the topographical representation, was plotted. The figure 3.17 shows the steps that 

were followed for plotting the ERPs, and Figure 3.18 shows the P300 potential.  

Plot > Sum/Compare comp. ERPs. > Datasets to average – Give the dataset 

numbers – Ok 

Figure 3.17 

The Steps Followed for Plotting the ERP 
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Figure 3.18 

The Event Related Potential P300 Obtained After the Analysis 
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CHAPTER IV 

Results 

 

The primary aim of the study was to profile the neurophysiological 

assessment (P300) in individuals with aphasia and neuro-typicals. Profiling was to 

identify the waveforms in the particular electrode sites and the brain activation in 

them. The study comprised a clinical group consisting 4 individuals with aphasia 

as participants and a control group with 4 neuro-typical individuals. This 

electrophysiological study did not include any statistical analysis.  

The waveform representing P300 in both clinical and control group was 

studied further by dividing the brain into five regions: frontal (F), left temporal 

(LT), central (C), right temporal (RT), and posterior (P) by grouping the 

electrodes at different brain areas (Appendix: A) and the amplitude and the 

latency were noted.  

The results are organized under the following headings: 

 Representation of waveform and topography in the clinical group 

 Representation of waveform and topography of aphasics in comparison 

with age-matched individuals 

 Representation of waveform and topography in the control group 

4.1. Representation of Waveform and Topography in the Clinical Group 

In the present study, out of the four participants in the clinical group who 

participated in the study, the P300 potential was present only in Participant A.  
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The Participant B, Participant C, and Participant D did not exhibit the 

P300 potential. The results of the P300 assessment of Participants A in terms of 

latency and amplitude in described in the following sections. The latency 

measured was 460 ms in the frontal, central, posterior, left and right electrode 

regions of the scalp, whereas it was 472 ms in the midline electrode region. The 

average latency measured was 460 ms among all the electrode sites. The values of 

latency measures can be related to the findings of Pararini et al. (2018), where it 

varied from 320 ms to 484 ms in healthy elderly subjects.  Similarly, the 

amplitude measured in the frontal scalp, central, midline, posterior, left and right 

regions was 0.723 µV, 0.369 µV, 0.459 µV, 0.549 µV, 0.464 µV and 0.331 µV 

respectively. The average amplitude measured was 0.512 µV among all the scalp 

electrode sites in Participant A. The value can also be correlated to the study of 

Pavarini et al. (2018), which shows the variation of amplitude from 2.2 µV to 

18.5 µV in the healthy elderly subjects.   

4.1.1 Participant A 

The graphical waveform representation of Participant A consists of two 

waveforms—an infrequent stimulus waveform color-coded with blue and a 

frequent stimulus waveform color-coded with red. The amplitude and latency 

measures are represented in Y-axis and X-axis, respectively.  The amplitude and 

latency measures of P300 assessment for different electrode sites are shown in 

Figures 4.1 and 4.2, the waveform representation and the summary of all the 

electrode sites are graphically depicted below in Figure 4.3 and 4.4.  
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Figure 4.1 

Waveforms of P300 in Different Electrode Sites of Participant A 

Frontal 

 

Central 

 

Midline 

 

 

Posterior 

 

 

Left 

 

Right 
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Figure 4.2 

Waveforms Showing the Average Responses for the Speech Stimuli at FCz 

 

The amplitude and latency measures of P300 in Participant A along with 

the average are compared among the scalp electrode regions, and the same is 

graphically represented in Figure 4.3 and 4.4, respectively. It is observed that the 

frontal region had the highest amplitude, followed by posterior region, average 

electrode, left region, midline region, central and right electrode region. With 

reference to latency, the midline region had prolonged latency, followed by other 

all electrode regions, which had similar latency values irrespective of different 

regions.  
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Figure 4.3 

 Amplitude Measures of P300 in Participant A 

 

 

Figure 4.4 

 Latency Measures of P300 in Participant A 
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The P300 potential was not found in participants B, C, and D, the 

waveform without P300 peak amplitude and latency is shown in Figure 4.5, 4.6, 

and 4.7. 

4.1.2 Participant B 

Figure 4.5 

Waveforms Showing the Average Responses for Participants B 

 

 

            4.1.3 Participant C 

Figure 4.6 

Waveforms Showing the Average Responses for Participants C 
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            4.1.4 Participant D 

Figure 4.7 

Waveforms Showing the Average Responses for Participants D 

 

 

 

The comparison of brain activation for frequent and infrequent stimuli at 

the peak latency is represented topographically for Participant A, B, C, D of the 

clinical group. Where the darker shades for the infrequent one show the brain 

activity to the infrequent stimuli, from the topographical representation it was 

seen that the brain region which was strongly activated was the posterior brain 

region/sites for Participants A. For Participant B, C, and D, the P300 potential 

was absent, and the topographical representation showed no activation towards 

the infrequent stimulus. The same is shown in Figure 4.8.  
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Figure 4.8 

Topographic Representation in the Clinical Group (Aphasic Participants) 

Participant A 

 

(a) Frequent stimuli            (b) Infrequent Stimuli 

Participant B 

 

Participant C 

 

Participant D 

 

(b) Infrequent Stimuli (b) Infrequent Stimuli (b) Infrequent Stimuli 

 

 

4.2 Representation of Waveform and Topography of Aphasics in 

Comparison with Age-Matched Individuals 

In this sub-section, the neuro-typical Participant 1 and the aphasic 

Participant A are compared in terms of latency and amplitude measures in the 

different scalp regions. In the frontal region, the latency for Participant 1 was 288 

ms, whereas the amplitude is 1.591µV, and for Participant A, the latency was 460 
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ms, and the amplitude was 0.723µV. The latency was 300ms, and amplitude was 

2.249µV for Participant 1 and latency 460ms and amplitude 0.369µV for 

Participant A in the central region. In the posterior region, for Participant 1, 

latency was 300ms and amplitude 2.636µV, whereas, for Participant A, latency 

was 460ms and amplitude 0.549µV. The latency and amplitude in the midline 

regions for Participant 1 are 300ms and 1.289µV, respectively, and for Participant 

A are 472ms and 0.459µV, respectively. For Participant A, in the right region, the 

latency was 460ms, and the amplitude was 0.331µV. For the left region of 

Participant A, the latency was 460ms, and the amplitude was 0.464µV. The 

average values of latency and amplitude of Participant 1 were 300ms and 

2.093µV, respectively. For Participant A, the average value of latency was 

460ms, and the amplitude was 0.512 µV. 

The waveform representation P300 of Participant A of the clinical group 

(P300 - present) and Participant 1 of neuro-typical (P300- absent) consists of two 

waveforms—an infrequent stimulus waveform color-coded with blue and a 

frequent stimulus waveform color-coded with red. The amplitude and latency 

measures are represented in Y-axis and X-axis respectively for different electrode 

regions in Figure 4.9 (frontal electrode site), 4.10 (central electrode site), 4.11 

(posterior electrode site), 4.12 (midline electrode site), 4.13 (right electrode site), 

4.14 (left electrode site) and 4.15 (average electrode site).   

The summary of all the electrode regions showing the differences in terms 

of latency and amplitude values between Participant A of clinical and Participant 

1 of the neuro-typical group is graphically depicted in Figure 4.16 and 4.17. 
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Figure 4.9 

Waveforms Showing the Responses at Frontal Region Sites for Participant A and 

Participant 1 

Frontal electrode sites 

PARTICIPANT A (Aphasia) PARTICIPANT 1 (Neuro-typical) 

  

 

 

Figure 4.10 

Waveforms Showing the Responses at Central Region Sites for Participant A and 

Participant 1 

Central electrode sites 

PARTICIPANT A (Aphasia) PARTICIPANT 1 (Neuro-typical) 
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Figure 4.11 

Waveforms Showing the Responses at the Posterior Region Site for Participant A & 

Participant 1 

Posterior electrode sites 

PARTICIPANT A (Aphasia) PARTICIPANT 1 (Neuro-typical) 

  

 

Figure 4.12 

Waveforms Showing Responses at Midline Electrodes Sites for Participant A &  

Participant 1 

 

Midline electrode sites 

PARTICIPANT A (Aphasia) PARTICIPANT 1 (Neuro-typical) 
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Figure 4.13 

Waveforms Showing the Responses of the Right Region Site for Participant A &  

Participant 1 

 

Figure 4.14 

Waveforms Showing the Responses of the Left Region Site for Participant A & 

 Participant 1 

 

Right Electrode sites 

PARTICIPANT A (Aphasia) PARTICIPANT 1 (Neuro-typical) 

  

Left Electrode sites 

PARTICIPANT A (Aphasia) PARTICIPANT 1 (Neuro-typical) 
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Figure 4.15 

Waveforms Showing the Responses from the Average Electrodes of Participant A & 

Participant 1 

 

Figure: 4.16 

Comparison of Latency at Different Electrode Sites for Individuals with Aphasia and Age 

Match Neuro-typical 
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Figure: 4.17 

Comparison of Amplitude at Different Electrode Sites for Individuals with Aphasia and 

Age Match Neuro-typical  

 

 

From the above Figure 4.16 and 4.17, it clearly depicted that the 

prolongation of latency and reduction of amplitude across distinct scalp regions in 

aphasic individuals when compared with the age-matched neuro-typical 

individual. 

The comparison of brain activation for frequent and infrequent stimuli at 

the peak latency is represented topographically for Participant 1 of control group 

was compared with Participant A of the clinical group. Where the higher 

activation for the infrequent one show the brain activity to the infrequent stimuli, 

from the topographical representation it was seen that the brain region which was 

strongly activated was the posterior brain region/sites and more centralized 
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significantly for both Participants 1 than Participant A. For Participant A and 

Participant 1, the P300 potential was present, and the topographical representation 

showed activation towards the frequent stimulus also with more activated 

electrode sites in Participant 1 compared to Participant A. The same is shown in 

Figure 4.18.  

 

Figure 4.18 

Comparison of Scalp Topography of Participant A with Participant 1 

                      Participant 1            Participant A 

                 

               Frequent                  Infrequent 

 

   

  Frequent                       Infrequent    

 

 

4.3 Representation of Waveform and Topography in Neuro-typical 

Individuals (NTI) 

The latency and amplitude measure in the different scalp regions, along 

with the average for Participant 1, is shown in Figure 4.19. Here, the latencies for 

frontal, central, posterior, and midline regions are 288ms, 300ms, 300ms, and 

300ms. The amplitude for the same Participant 1 in frontal, central, posterior and 

midline regions is 1.591 µV, 2.249 µV, 2.636 µV, and 1.289 µV respectively. The 
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average electrode latency is 300 ms, and the amplitude is 2.09 µV. The P300 

response was not seen in the right and the left region for Participant 1.  

Figure 4.19 

Waveforms Showing the Responses at Different Scalp Regions for Participant 1 (NTI) 
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The latency and amplitude measure in the different scalp regions, along 

with the average for Participant 2, is shown in Figure 4.20. Here, the latencies for 

frontal is 328ms and 1.241 µV, for the central region it was 328ms and 1.515 µV, 

for the posterior region it was 328ms and 1.335 µV, for the midline region it was 

328ms and 0.792 µV, for the right it was 364ms and 0.388 µV, and for the left, it 

was 328ms and 0.787 µV in their respective orders as seen in the review, whereas 

the average electrode site latency and amplitude were 328ms and 1.208 µV 

respectively. The same is shown in Figure 4.20. 
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Figure 4.20 

Waveforms Showing the Responses at Different Scalp Regions for Participant 2 (NTI) 
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Average 

 

 

The latency and amplitude measure in the different scalp regions, along 

with the average for Participant 3, is shown in Figure 4.21. , Here the latency 

values in the frontal, central, posterior, midline and left regions are 280ms, 

272ms, 276ms, 276ms, and 264ms, respectively, with the average 276ms. The 

values of amplitude for frontal, central, posterior midline, and left regions are 

0.584 µV, 1.361 µV, 1.536 µV, 1.152 µV, and 0.211 µV respectively with the 

average 1.545 µV. The same is shown in Figure 4.21. 

For Participant 4, in the frontal region, the value of latency was 328ms, 

and the amplitude was 1.472 µV; in the central region, the latency and amplitude 

are 328ms and 2.463 µV, respectively. For the posterior region, the latency and 

amplitude values are 328ms and 1.578 µV; for midline, the latency and amplitude 

values are 328ms and 1.436 µV; for the right region, the latency and amplitude 

are 328ms and 0.774 µV, and for the left region, the latency and amplitude are 

328ms and 0.993 µV respectively. The average for Participant 4 in terms of 



68 
 

 

latency and amplitude was 328ms and 2.227 µV, respectively. The same is shown 

in Figure 4.22. 

Figure 4.21 

Waveforms Showing the Responses at Different Scalp Regions for Participant 3 (NTI) 
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Figure 4.22 

Waveforms Showing the Responses at Different Scalp Regions for Participant 4 (NTI) 
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To summarize, the latency and amplitude value of each electrode site for 

participants 1, 2, 3, 4 of neuro-typical individuals are graphically represented in Figure 

4.23. The most active electrode region is found to be the posterior, frontal, central, 

midline, average, and left regions—the least active region right electrode site.  
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Figure: 4.23 

Comparison of Latency Measures in Participants of Neuro-typical Individual  

 

 

With reference to amplitude, the significant amplitude values were seen in 

electrode sites like posterior, central, midline, average, and frontal. There was no 

significant amplitude seen for some Participants in electrode regions like right and 

left. The same is shown graphically in Figure 4.24 with reference to each 

electrode site for participants 1, 2, 3, 4 of neuro-typical individuals. 
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Figure: 4.24 

Comparison of Amplitude Measures in Age Match Neuro-typical Individual  

 

 

The comparison of brain activation for frequent and infrequent stimuli at 

the peak latency is represented topographically for participants 1, 2, 3, 4 of the 

control group (NTI). Where the darker shades for the infrequent one show the 

brain activity to the infrequent stimuli, from the topographical representation, it 

was seen that the brain region, which was strongly activated, was the posterior 

brain region/sites for Participants 1, 2, 3, and 4.  
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Figure 4.25 

Topographic Representation in the Control Group (NTI participants) 
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CHAPTER V 

                                                   Discussion 

 

P300 is considered to be one of the endogenous potentials that are 

recorded with an oddball paradigm stimulus to generate responses to the 

infrequent stimulus from the cortical areas of the brain. In the present study, 

which was aimed to investigate the comparison between the aphasics and the 

neuro-typical individual for their amplitude, latency, and topographical 

representation, thus profiles the neuro-physiological assessment in the clinical 

population with adult language disorder, example- persons with aphasia. Further, 

for the ease in understanding, the discussion would be subcategorized into the 

following: 

 P300 potential in individuals with aphasia (IWA-clinical group) in 

comparison with neuro-typical (NTI-control group) with respect to latency 

and amplitude. 

 Topography in aphasics and neuro-typical (NTI). 

5.1 P300 Potential in Individuals with Aphasia in Comparison with Neuro-

typical with Respect to Latency and Amplitude 

In the present study, it was found that among the participants in the 

clinical group (IWA), Participant A had P300 responses with prolonged latencies 

and reduced amplitude compared to the participants in control group (NTI), 

Participant 1. The other three Participants (B, C, and D) of clinical group did not 

show prominent P300 responses compared to control group. The possible 
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explanation would be the alterations of the P300 observed in the neuro-

physiological assessment which is caused due to (1). The disruption of neural 

circuits generating or augmenting evoked potentials localized primarily in the 

temporoparietal cortical areas, and which might have resulted from stroke-related 

changes in the various neurotransmitters. To support the present findings of 

prolonged P300 responses of Participant A, Korpelainen et al. (2000) compared 

the P300 response of 38 aphasic patients with 29 healthy control subjects. The 

aphasic participants had an acute brain infarction, and P300 was recorded using 

an oddball auditory paradigm among these 38 brain infarct patients who reported 

mild neurological deficits at 3 and 12 months’ post-stroke period. The results 

indicated a slight prolongation of the latency of the P300 in patients with brain 

infarction. It was noted that the infarction did not influence the amplitude of the 

P300 or its distribution on the scalp.  

The second contributing reason could be the neurological injury that may 

also be aggravated by changes in behaviors during P300 recording such as fatigue 

because aphasic individuals tend to have fatigue in situations where concentrated 

attention is required  (Alvarenga, Lamônica, Costa Filho, Banhara, Oliveira, & 

Campo, 2005). Such rationale may be provided for three individuals in the present 

study who showed the absence of P300 in the clinical group as P300 is related to 

cognitive processes such as attention skills, auditory discrimination, and memory. 

So, the authors have concluded that in the presence of brain injury, such cognitive 

skills described may be compromised, which could explain the increase in latency 

and decrease in the amplitude for Participant A of clinical group or absence of 
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P300 in individuals with aphasia, the Participant B, C, D. Thus, these findings can 

be contributed for the good cognitive processes in some individuals with aphasia 

and neuro-typical to show the presence of P300. Another factor that must have 

helped for the presence of the potential can be the attentional allocation to the 

stimuli. The event-related potential P300 is a potential that is related to the 

attention and the memory processes (Grover, Chetri, Sood, Das & Nehra, 2012) 

and it requires active attention from the participant (Polich & Pitzer, 1999). The 

participant paying attention to the stimulus will increase the chances of the 

potential being present.  

The other contributing reasons would be the concerned site of the lesion 

among the participants who had a diffuse lesion in the brain which is stated as in 

Participant A: hypodensities in the left peri-rolandic cortex and temporo occipital 

cortex- subacute infarcts. Participant B: Hyperacute infarct involving frontal 

operculum and posterior frontal regions. Participant C: Left fronto-parieto-

temporal lobe chronic infarct with gliosis, Participant D: Mild interval decrease in 

the size and mass effect of subacute infarct of the left MCA territory involving the 

left gangliocapsular region, insular cortex, perito-temporal lobe. When P300 

recording was carried out, and the results revealed, three of the four participants 

(B, C, D) had absence of P300 responses. The possible reason could be that in 

Participant C and D, who had no P300 responses, had typical diffuse parietal 

lesion as observed in the neuroimaging findings, where the parietal area and its 

associated areas were one of the generator sites of P300; whereas, Participant A 

had acute onset of aphasia, neuroimaging findings reveal hypodensities in the left 
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peri-rolandic cortex and temporo occipital cortex- subacute infarcts. This shows 

no involvement of the parietal lobe and its associated areas leading to aphasia, 

thereby not affecting the P300 generator sites, which could have resulted in 

obtaining the P300. 

 To support this findings of lesion affecting P300, Linden (2005) aimed to 

identify the brain generators for the P300 responses and found that consistent 

pattern of generators has emerged in response to the oddball paradigm, with 

respect to the target-related responses. The generators found were the parietal 

cortex and the cingulate gyrus. The inferior parietal and prefrontal regions are 

activated with respect to novelty stimulus-related activations. In Participant B, C, 

D the neuro-imaging findings reveal hyperacute infarct involving frontal 

operculum and posterior frontal regions, which did not support the findings of 

Linden (2005) since the lesion was more prominent in the frontal, parietal, 

temporal and combined regions of all these lobes that is MCA infarct.   

 Stenklev and Laukli (2004) gave a possible explanation that the 

participant's age could also be a factor to result in prolonged latency and reduced 

amplitude. The study further states that the presence of P300 is reported only in 

52 percent of subjects over the age of 60. This can be correlated to the present 

study as the Participant B belonged to the age group of 60-70 years. In addition to 

the age factor, Participant B had neurological insult in the brain's frontal region.  

According to, Milner (2014); Shahin, Alain, and Picton (2006), the 

neurological lesions in frontal areas after stroke revealed P300 findings with 

diminished amplitude and latency prolongation. Moreover, it has also been noted 
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the absence of response in some cases with neurological insult, which explains the 

absence of P300 in Participant B, C, and D. 

 The possibility of P300 in individuals with aphasia is characterized by the 

individual variables like type of aphasia, undergoing rehabilitation, neuronal 

toxicity, and age. The factor age is discussed in the previous section according to 

Alvarenga, Lamônica, Costa Filho, Banhara, Oliveira, and Campo, (2005). The 

latency and amplitude of the P300 component in the aphasic individuals were 

observed and compared with the control group, suggesting increased latency and 

decrease in the amplitude of this P300 component. However, the authors stated 

that the control group, which was age, and gender-matched, showed shorter 

latency than the group of aphasic individuals. Thus, these facts suggest that 

neurological injury can justify the increase in P300 latency, which can also be 

aggravated by behavior changes like fatigue during P300 recording as discussed 

in the previous sections. Aphasic individuals tend to be fatigue in situations that 

require concentrated attention. Light drowsiness during the recording also affects 

the P300 response (Koshino et al., 1993). Such reasoning could be given to three 

individuals who showed the absence of P300 in the clinical group since P300 is 

related to cognitive processes reflected in its components and sub-components of 

attention skills, auditory discrimination, and memory. So, the authors have 

concluded that in the presence of brain injury, such cognitive skills described may 

be compromised, which could explain the increase in latency and decrease in the 

amplitude or absence of P300 in individuals with aphasia. The participants (B, C, 
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and D) of the present study who had an absence of P300 responses can be 

attributed to these justifications.   

            In the present study, Participant A had the presence of P300 with 

prolonged latency and reduced amplitude. This can be justified by the explanation 

in the study by Becker and Reinvang (2007) that, severe and moderate aphasic 

patients have their ability to detect rare target syllables among many standard 

syllables. It was investigated, and the electrophysiological processes involved 

were studied. Given the promising task performance (discrimination task) of the 

aphasics, they observed some critical variations in their electrophysiological 

processing measurements. Nonetheless, in the aphasic groups, the P3 component 

was not significantly varied, suggesting no severe impairments in the target 

recognition, thus relates to the fact that the aphasic patients were able to identify 

the target syllables behaviorally. The possible explanation provided that the 

aphasic participants were able to execute the existing tasks simultaneously 

successfully. The electrophysiological variables were significantly attenuated in 

the stimulus discrimination in some aphasic subjects. This was not based on 

linguistic analysis but mainly the acoustic features. This strategy is appropriate in 

a task with a minimal set of stimuli and no demands for semantic interpretation 

but is not efficient in a task of naturalistic comprehension as in the present study. 

Where the syllables used in the present study as stimulus were just for 

identification as frequent and infrequent, without any association of linguistic 

expression or comprehension. Thus, the acoustic variable of discrimination ability 

has played a major rule to elicit P300 response. This study investigated the speech 
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sound processing during a syllable detection task in aphasia recording event-

related potentials. The aphasic subjects were able to perform the task almost 

without mistakes, and the processes associated with the identification of the target 

(P3) were not significantly reduced. However, electrophysiological components 

indicating primary stimulus analysis (N1) and associated stimulus categorization 

and discrimination (N2) indicated reduced processing, which implied weakness in 

more complex and naturalistic comprehension tasks. As one of the subjects 

(Participant A) had the presence of P300 with prolonged latency and reduced 

amplitude could be due to his good auditory discrimination ability.  

 With reference to stimulus variable, in the present study, it was found that 

among the participants in the control group where Participant A had P300 

responses, whereas the other three participants did not show prominent P300 

responses. According to the study by Lew, Slimp, Price, Massagli, & Robinson 

(1999), the healthy individuals with no medical history of neurological complaints 

had robust P300 responses for the speech stimulus when compared to tonal 

stimulus. Nevertheless, in this study, the speech stimulus included was infrequent 

as ‘mommy’ and frequent stimuli as 1000Hz tone, which formed as an oddball 

paradigm. In comparison to the present study, there was a gross difference in the 

stimulus used in their study, which resulted in better speech evoked P300 

responses than tone evoked P300 responses as reasoned out. They conducted 

P300 testing in an intensive care unit, where the patient's response to a tonal 

stimulus could be fatigued by numerous beeping machines. In such a situation, the 

brain perceives tones as part of the background, whereas during the speech-
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evoked P300 testing, almost all subjects remarked that the word 'mommy' 

provided mental arousal when they were on the verge of falling asleep. The 

present study included the speech stimulus (infrequent: /da/ and frequent: /ga/) 

and had contradicting results, which revealed that only one of the participants had 

P300 responses. In contrast, the other 3 participants did not have P300 responses; 

the possible reason could be that P300 latency increases when the discrimination 

targets are more complicated than the standard because latency is sensitive to the 

task processing demand. On the other hand, the P300 amplitude is higher in more 

manageable tasks, and decreases as tasks become more complicated.  

Similarly, in the study by Massa, Rabelo, Matas, Schochat, & Samelli 

(2011) it was found that the P300 latencies for verbal stimuli were significantly 

higher than those of non-verbal stimuli. The above finding was also supported by 

Linden (2005) and Polich (2007) that he generators found were the parietal cortex 

and the cingulate gyrus. The inferior parietal and prefrontal regions are activated 

with respect to novelty stimulus-related activations. However, amplitudes by 

speech stimuli were significantly lower when compared to non-verbal stimuli, 

which could be because the discrimination of verbal stimuli (in this study, 

syllables /ba/ and /da/) is a more complicated and challenging task compared to 

discrimination of non-verbal stimuli (Martin, Tremblay, & Korczak, 2008).  

Other stimulus variables like the modality of stimulus can also be 

considered as a contributing variable. In the present study, the unimodal (auditory 

mode) stimulus was used, which resulted in absent P300 response in three of the 

participants and present in only one participant. According to the study by  (Li, 
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Wu, & Touge, 2010; Sangal & Sangal, 1996) the auditory-visual mode was 

compared with auditory mode and visual mode as separate parameters. They 

found that behavioral identification of the auditory stimulus was improved when 

integrated with the auditory and visual stimuli in the region of the brain. The 

absence of P300 in the present study could also be attributed to unimodal 

stimulation. 

5.2 Topography in Aphasics and Neuro-typical Individual (NTI) 

With reference to the topographical differences in P300 potential being 

present in Participant A of clinical group and Participant 1 of control group was in 

terms of scattered responses in the brain scalp regions of Participant A (IWA) and 

more centralized activation in Participant 1 (NTI). These responses were seen 

only for infrequent stimuli in Participant A (IWA) and the topographical 

representation was seen for infrequent and frequent stimuli in Participant 1(NTI).  

The present study with reference to neuro-typicals is in support with the 

previous studies (Picton & Hillyard, 1974) (Pfefferbaum, Ford, Wenegrat, Roth, 

& Kopell, 1984) (Sangal & Sangal, 1996) on neurotypical individuals in the age 

range of 16-25 years, 26-35 years and 35-65years, where they indicated the 

prolonged latency and reduced amplitude compared to the younger group. Thus 

the present study confirmed the previously reported increase in latency (both in 

auditory & visual mode) and a decrease in amplitude with age (both in auditory & 

visual).  

Visual P300 amplitudes were of an overall larger magnitude than auditory 

P300 amplitudes. There were no other differences in P300 amplitudes or latencies 
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by gender, modality, or side of the scalp. There were no significant topographical 

differences in P300 amplitudes or latencies by gender, age-group, modality, or 

modality or side of the scalp.  

Group-averaged auditory and visual P300 waveforms at the group mean 

P300 latency at Cz, showing a right centroparietal sink surrounded by sources. 

This suggests a significant right centroparietal P300 generator. Whereas, in the 

present study the generators were scattered and there was very poor representation 

in right and left electrode sites for all the participants of control and clinical group 

except the Participant A (IWA) and Participant 1 (NTI).  

The responses of Participant A (IWA) and Participant 1 (NTI) showing 

more central and midline electrode site activation can be supported by Katayamaa 

and Polich (1999). The target stimulus in each modality elicited a P300 

component that was most significant over the parietal and mid-line electrode sites.  

Moreover, a shift in amplitude over midline electrodes (Fz, Cz, Pz.) 

increased from the frontal (Fz) site along the parietal mid-sagital plane (Pz)          

( Johnson, 1993). The target P300 for the auditory task was smaller in amplitude 

and shorter in latency compared to the visual task. Also, it is mentioned (Soltani 

& Knight, 2000) that the central regions consistently attributed in generating 

detection-related brain activation that includes the temporal-parietal junction, 

medial temporal complex, and the lateral prefrontal cortex. Such similar results 

were observed in the current study in both the aphasics (only in Participant A) and 

neuro-typical individuals (Participant 1, 2, 3 and 4). 
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           CHAPTER VI 

Summary and Conclusion 

 

The auditory P300 is an evoked potential of positive long latency peak, 

which helps in the central nervous system's research of the aural cortex. It helps to 

depict the cortical activity that includes discriminative, integrative and attention 

abilities, allowing the finest indicator of cortical processing velocity through 

auditory stimulation. In the P300 studies so far, the consequence of neurological 

damage and the older population is frequently noted to be abnormal in cognitive 

impaired patients. Amplitude and latency are measured in the typical and clinical 

population for the peak and widely researched parameters. Information processing 

influences the P300 parameters such as latency and amplitude and also influences 

the cognitive skills such as attention, stimulus assessment, judgement, memory 

processing, and input auditory stimulus decision making.  

Auditory P300 is a positive peak that occurs after stimulus starts at about 

300ms. The produced potential is affected by the activation of various neocortical 

and limbic areas in the brain and has two functionally distinct P300 sub-

components: the P3a, which is maximally represented over the front-central areas, 

and the P3b, which is maximally represented by the posterior scalp places 

(Squires, Hillyard & Squires, 1975). However, there was a need to assess the 

activation of the same neocortical and limbic areas in the brain of individuals with 

aphasia before they initiate speech-language therapy. 
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The P300 reflects simultaneous activity in several areas of the brain, 

including temporoparietal, neocortical and higher limbic systems (Halgren, 

Baudena, & Clarke et al., 1995). P300 amplitude is also the level of attention 

dedicated to a particular task and linked with superior mental efficiency 

(Gonsalvez & Polich, 2002). Therefore, P300 amplitude can be considered as a 

measure of central nervous system activity reflecting incoming data processing 

when integrated into the depictions of stimulus memory and the context in which 

the stimulus exists. Consequently, variation in the amplitude of P300 is assumed 

to represent the degree or quality of the information processing. 

 Studies suggest that in global aphasia, passive P300 can be used to 

monitor their recovery. In other words, it is possible to use P300 recording for 

prognostic purposes in aphasics (Nolfe, Cobianchi, Mossuto-Agatiello & 

Giaquinto 2006). Therefore, there is a need to imply the neurophysiological 

assessment (P300) for comparing the neuro-typical individuals with the 

individuals with aphasia to obtain the neurophysiological data to distinguish 

between the normal population and the individual with aphasia. Hence, the 

present study was aimed to conduct a neurophysiological assessment (Event 

Related Potential-P300) in individuals with aphasia in comparison with the neuro-

typical individuals. Hence, the objectives of the present study were (1) To conduct 

a neurophysiological assessment (Event Related Potential-P300) in individuals 

with aphasia in comparison with the age matched neuro-typical individuals and 

(2) To obtain the topographical representation of Event Related Potential (P300) 
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response of individuals with aphasia in comparison with the neuro-typical 

individuals. 

The clinical group comprised of four individuals with aphasia in the age 

range of 20-60 years and the control group comprising four age matched neuro-

typical individuals selected from Mysore after following general and specific 

inclusion criteria. The P300 recording was carried out using Net Station 5 

Geodesic EEG Software Version 5.4.2 instrument placed in a sound-attenuated 

and electrically shielded room, where the noise levels are within permissible 

limits (ANSI S3.1-1999). The speech stimuli used for testing was syllables /da/ 

and /ga/, where the frequent one was /da/ and the infrequent one (target) was /ga/. 

The inter stimulus interval was 2000 ms. The ERPs that was used to record was 

P300, as per the guidelines provided by Duncan et al. (2009). After the ERP 

recording, the data was further analyzed in the MATLAB software to extract the 

P300 from the recorded event related potential. Graphical representation of the 

waveforms and topographical representation of scalp regions are documented.  

The results are explained under three headings. Firstly, the representation 

of waveform and topography in the clinical group (Participant A, B, C, D), the 

Participant A only showed P300 responses. There was increase amplitude in 

frontal electrode site followed by posterior electrode site, average, midline, 

central and left and right electrode regions. With reference to latency, the midline 

electrode site had highest latency compared to other electrode regions. P300 

response was absent for Participant B, C, and D. The topographical representation 

was scattered for individuals with aphasia.  



87 
 

 

Secondly, the representation of waveform and topography of aphasic in 

comparison with age matched neuro-typical. Here the Participant A of clinical 

group and Participant 1 of control group shown the presence of P300 and other 

participants of clinical and control group did not show the P300 responses. The 

Participant A had prolonged latency and reduced amplitude compared to 

Participant 1.  

Thirdly, the representation of waveform and topography in the control 

group. The topographical representation showed the P300 responses being 

strongly activated in the posterior sites of brain regions for both groups but the 

highest activation was reduced in individuals with aphasia when compared to the 

neuro-typical, indicating the reduced activation of brain region in individuals with 

aphasia. 

The alterations of P300 observed in the neuro-physiological assessment 

could be explained with reference to some contributing factors. The first factor 

could be the disruption of neural circuits generating evoked potentials localized 

primarily in the temporoparietal cortical areas, which might have resulted from 

stroke-related changes in the various neurotransmitters (Korpelainen et al., 2000).  

The second contributing reason could be the neurological injury that may 

also be aggravated by changes in behaviors during P300 recording such as fatigue 

because aphasic individuals tend to have fatigue in situations where concentrated 

attention is required  (Alvarenga, Lamônica, Costa Filho, Banhara, Oliveira, & 

Campo, 2005). So, the authors concluded that in the presence of brain injury, 
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cognitive skills like attention, auditory discrimination, and memory may be 

compromised.  

The third one could be the site of the lesion among the participants who 

had a diffuse lesion did not show P300 responses. According to Linden (2005), 

the generators found were the parietal cortex and the cingulate gyrus. The inferior 

parietal and prefrontal regions are activated with respect to novelty stimulus-

related activations. These regions were affected in the clinical population 

involved in the present study. 

The participant’s age could be the fourth factor to result in prolonged 

latency and reduced amplitude, which is supported by Stenklev and Laukli 

(2004). 

The fifth contributing factor could be, cognitive processes –attention 

skills, auditory discrimination, and memory. So, the authors have concluded that 

in the presence of brain injury, such cognitive skills described may be 

compromised, which could explain the increase in latency and decrease in the 

amplitude or absence of P300 in individuals with aphasia.  

The sixth contributing factor was related to types of tasks during the 

testing period.  As the task performance (discrimination task) of the aphasics were 

successful, some critical variations in their electrophysiological processing 

measurement were observed and the electrophysiological variables were 

significantly attenuated in the stimulus discrimination in some aphasic subjects. 

This was not based on linguistic analysis but mainly the acoustic features. This 
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strategy is appropriate in a task with a minimal set of stimuli and no demands for 

semantic interpretation but is not efficient in a task of naturalistic comprehension 

as in the present study. Thus, the acoustic variable of discrimination ability has 

played a major role to elicit P300 response. In contrast, the other 3 participants 

did not have P300 responses; the possible reason could be that P300 latency 

increases when the discrimination targets are more complicated than the standard 

because latency is sensitive to the task processing demand. On the other hand, the 

P300 amplitude is higher in more manageable tasks, and decreases as tasks 

become more complicated.  

Other stimulus variables like the modality of stimulus can also be 

considered as a contributing variable. In the present study, the unimodal (auditory 

mode) stimulus was used, which resulted in absent P300 response in three of the 

participants and present in only one participant according to Li, Wu, and Touge, 

(2010) and Sangal and Sangal, (1996). 

The topographical differences in P300 potential being present in 

Participant A of clinical group and Participant 1 of control group was in terms of 

scattered responses in the brain scalp regions of Participant A (IWA) and more 

centralized activation in Participant 1 (NTI). These responses were seen only for 

infrequent stimuli in Participant A (IWA) and the topographical representation 

was seen for infrequent and frequent stimuli in Participant 1(NTI). The present 

study with reference to neuro-typicals is in support with the previous studies 

(Picton & Hillyard, 1974) (Pfefferbaum, Ford, Wenegrat, Roth, & Kopell, 1984) 

(Sangal & Sangal, 1996). The responses of Participant A (IWA) and Participant 1 
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(NTI) showing more central and midline electrode site activation was supported 

by Katayamaa and Polich (1999). Soltani and Knight (2000), mentioned in their 

study that the central regions consistently attribute in generating detection-related 

brain activation that include the temporal-parietal junction, medial temporal 

complex, and the lateral prefrontal cortex. Such similar results were observed in 

the current study in both the aphasics (only in Participant A) and neuro-typical 

individuals (Participant 1, 2, 3 and 4). 

6.1 Implications 

 This study helped us to compare and evaluate the effect of aphasia 

symptoms, their course of speech-language therapy (yet to continue regular 

speech-language rehabilitation) and the effect of their cognitive skill on P300 

assessment. Thus, the P300 recording could be used as a non-invasive neuro-

physiological assessment used to monitor or check the prognosis of individuals 

with aphasia during their course of speech-language therapy and use the same 

evaluation during the speech-language training which facilitates improvement in 

attention skill of individuals with aphasia. Therefore, ERP is a useful method, 

which can be utilized for these non-verbal individuals who cannot provide any 

motoric responses due to hemiplegia during the assessment of the routine 

cognitive and attentional allocation skills. It also helps in differentiating 

individual with aphasia from that of neuro-typicals.   
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6.2 Future directions 

The smaller sample size in both the clinical and the control group is one of 

the limitations of this study. The unequal distribution of the subjects among the 

males as well as the other factors like food intake, sleep, alcoholism, behavioural 

scores and exercise that influences the P300 components were not considered in 

the study.  

The homogeneity among the aphasics of different types in the clinical 

group was also not considered. It is suggested that further investigations should be 

carried out to elucidate the true relationship between age, education, gender, 

behavioural scores and the P300 in larger sample size with equal distribution with 

respect to the gender in comparison to the age matched neuro-typical individuals. 

 Finally, the review identified the lack of studies designed to specifically 

investigate the scalp topography in individual with aphasia. Similar studies can be 

carried out in future with homogeneity in the group of aphasics of different types 

and sites of lesion and larger sample size.  

This study can also lead to the future direction where the effects of speech 

and language therapy can be investigated in aphasics by comparing subjects 

before and after the therapy.  
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Appendix A 

Electrode selection to form specific sites 

 

 

 

        

Electrode distribution of 128 channel 

Geodesic sensor net according to Bian et al., 

(2014) 

Color coded for the convinience of the ERP 

analysis 
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 Central (C) 

 

Midline (M) 

 Posterior (P) 

 Left Hemisphere 

 Right Hemisphere 

 Left Temporal 

 Right  Temporal 



II 
 

 

The interested electrodes were selected to detect EEG power in different 

regions and inter-/intra regions, the brain was divided into five regions: frontal 

(F), left temporal (LT), central (C), right temporal (RT), and posterior (P).  

Frontal: E32, E25, E21, E14, E18, E1, E26, E22, E15, E9, E2, E27, E23, E18, 

E16, E10, E3, E123, E24, E19, E11, E4, E124, E12 & E5;  

Central: E6, E7, E13, E20, E29, E30, E31, E36, E37, E42, E53, E54, E55, E79, 

E80, E86, E87, E93, E104, E105, E106, E111, E112 & E118;  

Posterior: E61, E62, E78, E60, E67, E72, E77, E85, E59, E66, E71, E76, E84, 

E91, E65, E70, E75, E83, E90, E64, E69, E74, E82, E89, and E95;  

Midline: E17, E15, E11, E6, E55, E62, E72 and E75;  

Right: E14, E8, E1, E121, E114, E100, E95, E89, E82, E83, E90, E96, E101, 

E108, E115, E122, E2, E9, E10, E3, E123, E116, E109, E102, E97, E91, E84, 

E76, E77, E85, E92, E98, E103, E110, E117, E124, E4, E5, E118, E111, E104, 

E93, E86, E78, E79, E87, E105, E112, E106, and E80; 

 Left: E21, E25, E32, E38, E44, E57, E64, E69, E74, E70, E65, E58, E50, E45, 

E39, E33, E26, E22, E18, E23, E27, E34, E40, E46, E51, E59, E66, E71, E60, 

E52, E47, E41, E35, E28, E24, E19, E12, E20, E29, E36, E42, E53, E61, E54, 

E37, E30, E13, E7 and E31; 

Average: Grand average from all the electrode sites. 

 

 

 


